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siderable difficulty in assessing monetary values for eco-
system services, and they are commonly left out of policy
decision making processes (Ecosystem Services, 2013).
 Although the global carbon cycle and its partici-
pation in the virtually all social ecological systems is out
of scope for this study, San Juan County, like many
localized regions, can participate in mitigating climate
change by sustainably maintaining adequate forest cover
across all islands that will sequester and store the carbon
produced by an increasing human  population. Climate
change is widely accepted by the scientific community as
a human caused problem primarily from the burning of
fossil fuels and releasing carbon in the form of carbon
dioxide (CO2) into the atmosphere. Global deforestation
contributes to the problem by removing the sink that tree
biomass provides for removing carbon from the atmo-
sphere. The pursuit of carbon neutrality or carbon se-
questration surplus is seen a main tactic for combating
climate change.
 The attainability of this carbon neutrality goal is
dependent of being able to quantify forest cover as well
as estimates of carbon sequestration and storage provid-
ed by this forest cover. This information can be used to
determine forest management plans that will likely differ
from those that are in place in the county already. At-

 This preliminary remote sensing study of the
ecosystem services provided by the forests of San Juan
Island, WA is presented by University of Washington
graduate students in collaboration with Kwiaht, Center
for the Historical Ecology of the Salish Sea. Only eight
weeks were allocated to creating a simple “proof of
concept” that can be used to support a more detailed
and more extensive study of how these forests affect the
carbon cycle. There are two components to this study: a
survey of available remote sensing methods and data,
and a measurement of ecosystem services.
 Healthy forested lands provide intangible benefits
to people in and near them. These natural assets are
commonly referred to as “ecosystem services.” More spe-
cifically, ecosystem services are commonly defined as
“benefits people obtain from ecosystems” (Ecosytem Ser-
vices, 2013). This includes carbon storage and sequestra-
tion, stormwater runoff mitigation, decreases in erosion
pressures, decreases in sedimentation rates, increased
biodiversity, energy savings, and increased aesthetic
beauty in urban environments (Urban Forest, 2012; Eco-
system Services, 2013). These services are traditionally
viewed as natural benefits and a part of the public good.
Since they commonly lack formal markets, there is con-



only on undisturbed shoreline. Given a growing human
population on the islands of San Juan County, put very
simply, the sustainability of the carbon cycle depends on
growing enough Douglas Fir trees to compensate for the
growing number of cars. An extensive carbon footprint
study to determine any forest coverage threshold for
carbon neutrality would also aid the county in long term
carbon neutrality goals. However, San Juan County has
ignored this ecosystem service.
 In fact, tax incentives are still available for cutting
down Douglas Fir trees. Designated Forest Land receives
the largest tax break available in San Juan County, and
the stated goal of the program is to encourage “maximum
timber production.” The program defers property tax
revenues until a later date when forests are harvested.
Not all land-owners with “Designated Forest Land” are
interested in harvesting timber, and  some are even
opposed to it. But enrollment in the program requires
filing and following a 30-year timber management plan
dictating future forest harvesting that is increasingly
being enforced by the County.
 The design of this taxation program suits the
historical importance of the logging industry. Extensive
cutting for timber and industrial fuel continued until
the old-growth forest virtually vanished by the 1940s.

tempting to use remote sensing techniques to attain these
estimates of forests and their carbon mitigating ecosys-
tem service is a logical first step and is the scope of this
study.
 The most common forest types on San Juan Island
are characterized by the co-occurrence of Douglas Fir
( ) with other tree species such as
Grand Fir ( ) and Western Red Cedar (

) or with undergrowth species such as Salal
( ) and Ocean Spray (

). Pacific Madrone ( ) which grows
on steep, sunny, shorelines, and Red Alder ( )
which grows in low-lying, wet, woodlands, are excep-
tions to the coniferous pattern. Sequestering carbon is the
most important ecosystem service that Douglas Fir forests
provide. Wet woodlands provide better habitat for sup-
porting animal biodiversity, but Douglas Fir forests pro-
vide the largest terrestrial carbon sink. Both forest types
help regulate runoff and erosion. (Chappell, 2006)
 Douglas Fir trees are the only organisms sequester-
ing significant carbon on San Juan Island. Peat bogs and
juniper trees ( ) are notable carbon
sink because they store carbon for a long time without
releasing it back into the atmosphere, but peat bogs cover
less than 1% of San Juan County and juniper trees grow



2012). Seattle’s long term Urban Forest Management
Plan advocates a goal of increasing the canopy coverage
from 23% to 30% by 2037 in order to increase the value
of this storage capacity as well as realize more benefits in
terms of stormwater runoff mitigation, energy savings,
and increasing the aesthetic quality of all regions and
neighborhoods (Urban Forest, 2012).
 Seattle’s assessment and goals rely on a heavy
hands-on data collection effort, coupled with using i-
Tree Eco as the data analysis software. Eco requires a
boots-on-the-ground bottom-up approach to get an
actual inventory of individual species and metrics of
individual trees like height and diameter at breast height.
In contrast, our study is centered on the top-down ap-
proach, where we look at remote sensing techniques to
quantify the forest on the islands as best as possible
(Nowak). This is cheaper and faster approach so long as
data is available, however, disadvantages include need-
ing access to some specific software (like ArcMap,
SPRING, or Fusion) and the possible falsehoods and er-
rors generated by inaccuracies in the remote sensing
data or processing techniques (Nowak).
 A freeware application called SPRING categorizes
a land cover raster from orthophotos. The user creates
classification rules from the bottom up, by manually

Island forests were commercially convenient, because
logs could be rolled down to the beach and floated
away. Despite the tax incentives, harvest yields have
steadily dropped. Some previously logged land appears
to have regrown, but forest productivity is low and the
forests have not had time to mature. The current rate of
harvest is depleting the forest. (Schroeder)
 Due to the historical logging, the remaining forests of
the San Juan Islands strongly resemble commercially
managed timber stands. Nearly 70% of the trees are a
single species, Douglas Fir. Most of the individual trees
are between 50 and 75 years old (Schroeder). As the
forest matures, the canopy will close and tree growth
will slow. The most rapid acceleration of carbon
sequestration takes place before that happens, although
the rate continually increases as trees grow. The
taxation system could be restructured to value the
Douglas Fir forests' ability to provide ecosystem services
like removing carbon from the atmosphere.
 The extensive Seattle Ecosystem Values report pro-
vides a nearby example of policy driven by ecosystem
services assessment. It estimates that the City of Seattle’s
urban forests cover roughly 23% of the city across all
regions, while providing a carbon storage capacity of 2
million metric tons (or 2.2 million short tons) (Ciecko,



transforms raw LiDAR point cloud data into DEMs and
other surfaces. Although it is a powerful application, the
user interface is somewhat confusing at first, and the
data processing capabilities are difficult to understand.
The user can execute great control on the outputs and
metrics. However, commercially produced DEMs are
sufficient for this preliminary study, so customizing the
LiDAR surface isn't an important part of the workflow.
 ArcMap ModelBuilder has the capability to link
tools and pull together the land cover raster and the
LiDAR DEMs (Fig 1). A new toolbox automating all of the
the ArcMap methods used in this study makes it much
easier to repeat the methods used in this study, and
ModelBuilder diagrams present the workflow in a format
familiar to many GIS analysts.
 At the Twelfth Biennial USDA Forest Service Re-
mote Sensing Applications Conference in 2008, Jim
Muckenhoupt presented a very clever method for delin-
eating individual trees from a LiDAR DEM. They flipped
a vegetation height raster upside down, and then ana-
lyzed it with ArcMap hydrology tools. Each treetop in the
canopy of the forest becomes a drain, or sink, and the
depth of the sink equals the height of the tree.
(Muckenhoupt, 2008). Some of the resulting peaks are
actually rooftops, not trees, but many of those false posi-

classifying a large sample of pixels. A land cover raster is
crucial to remote sensing ecosystem services and nothing
appropriate to this study is readily available, so SPRING is
an important part of the workflow. An extremely well
written, at length step by step guide was published by
Moskal et al. in 2011 (Moskal, 2011). This English lan-
guage resource is especially valuable because SPRING is
a product of the Brazilian government, and therefore
most of the technical support information is written in
Portuguese.
 I-Tree is a suite of freeware applications that out-
put maps and tables measuring ecosystem services based
on specific data resources. Using the software is relatively
easy, and the methods are well documented. A broad
range of ecosystem services can be surveyed, but the tools
vary in the data input needs. Some applications rely on
hands-on site specific species inventories and metric
measurement surveys (i-Tree Eco and Streets), while
others use on-line data resources like the National Land
Cover Database and Google Maps (i-Tree Vue and Cano-
py) along with national average calculated forest metrics
to estimate ecosystem services. The i-Tree outputs can be
used to calibrate other methods that have greater appli-
cability.
 Another freeware application called FUSION



erous plots. Their general regression equation:
AboveGroundBiomass =
 0.342 * (MeanCanopyHeight)2 +
  2.086 * (MeanCover * MeanCanopyHeight)

is reported to explain 87% of the variance at the tem-
perate coniferous plots and 84% of the variance at all
plots. Although the forests in our study are temperate
and coniferous, they grow in a drier climate with poor-
er soil than the Western Oregon forests studied by Lef-
sky. As mentioned earlier, the forests on San Juan Island
are also very homogeneous and immature. However,
until Kwiaht is able to perform their own field calibra-
tion, Lefsky's model seems to be the best available.
(Lefsky 2002)
 This study is only a starting point for quantifying
carbon in the forests of the San Juan Islands. Currently,
LiDAR and orthophotos of San Juan Island are only up-
dated once or twice in a decade, so they provide a snap-
shot in time, not long-term monitoring. The low
precision of this preliminary study would also be prob-
lematic for long term monitoring, because small chang-
es over time could be lost in the noise. However, a
reliable baseline will be useful as new methods and data
sources, such as satellite hyper-spectral imagery, make

tives can be eliminated by comparison with land cover
data. Basins are delineated from sinks and used in turn to
calculate percent forest cover. ArcMap's raster calculator
is also the best tool for calculating allometric carbon
analysis.
 A quick test-run only scratches the surface of a GIS
software application's capabilities. Years of experience
with ArcMap provide useful familiarity with the user
interface, but do not make one an expert at every tool.
The freeware applications tested in this study have nar-
rower scope, but also have limited technical support and
plenty of quirks. In this study we attempted to judge the
accessibility of each program against the value of the
results it produces. However, the software guidance in
this study is based on our own opinions, formed in the
midst of the steep beginning of the learning curve.
 Allometric analysis is based on the mathematical
relationship between carbon density and the size of the
trees. Extensive research in the amazon rainforest and
other tropical areas shows carbon density has a parabolic
relationship to mean canopy height, basal area, and wood
density (Asner 2009). The exact relationship varies by
region and forest type, so the equation must be calibrated.
 Lefsky modeled carbon density at 112 temperate
deciduous, 21 temperate coniferous and 16 boreal conif-



regular monitoring feasible.
 Even a rough approximation supports the argu-
ment in favor of measuring ecosystem services. Hope-
fully this “proof of concept” will be used to justify and
procure funding for Kwiaht to perform a six to eight
week study employing two GIS analysts, two field biolo-
gists, and one intern, full time. The workflow of this fu-
ture study would be guided by our preliminary survey
of the available software. Kwiaht operates very frugally
using a business model copied from small research sta-
tions in third-world countries, so our focus on freeware
and free data suits them. They also often train volunteers
from the local community, so many of the time-inten-
sive data processing tasks (e.g. “training” SPRING and
i-Tree) could be shared. Having a trained botanist
ground-truth the land cover raster and calibrate the al-
lometric regressions would greatly improve the reliabil-
ity of the results.



infrared band was not available online, for free online
but could be purchased.. Using ArcMap, the data were
clipped to the SJI shoreline, and exported as a
georeferenced *.tif file (0.3 GB). SPRING 5.2.3 (32-bit
version) is  Object Based Image Analysis (OBIA)
freeware program designed by the Brazil National
Institute for Space Research.
 In SPRING, the project's projection and bounding
box were manually entered before the image was
imported. The segmentation window's bounding box
was adjusted to divide the north end of the island from
the south end, in order to limit the file size. The north
and south ends of the island were separately segmented
according to empirically derived parameters (similarity
= 30, area = 40) which correctly identified easily
recognizable features like tree stands, roads, buildings,
pastures and parking lots. Segmented features were
classified into three land cover types: Forest,
Grassy/Non-Forest, and Urban/Impervious surface.
Several million pixels were assigned to the
classifications in order to “train” SPRING. The
classification type was set to “Bhattacharya” and the
acceptance threshold was set to “99.9.” The resulting
classifications were mosaicked together and exported as
a *.tif georeferenced image.

 For a more detailed description of the pitfalls and
sucesses of our software exploration, see Appendix A.

 All processing was carried out on a 2.8 Ghz Intel
Dual Core; 8G RAM laptop.

 San Juan Island (SJI) shoreline was extracted from
the San Juan County shorelines published by NOAA in
2011 and used to extract all rasters and images. The
area of San Juan Island (143 km2) was near the limit of
reasonable data processing time, although methods
described below can be applied to other areas of interest
inside or outside San Juan County. The processing
requirements for this type of analysis can be very high,
even if only looking at San Juan Island, as is the scope
for this report.

 A high resolution (1m) aerial photography mosaic
of San Juan County (2.24 GB) in 2011 was provided by
the National  Agriculture Imagery Program. The
projection for ths data was NAD83 UTM Zone 10N.
Only 3 spectral band were obtained, because the near-
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 Raw LiDAR point cloud data of San Juan County
in 2009 was provided by the San Juan County GIS
department and attempts were made to derive surfaces
in FUSION 3.30, a freeware application designed by the
USDA Forest Service’s Pacific Northwest Research
Station. These attempts were not successful, although
tutorials run on sample data were successful. For this
analysis, large amounts of time learning to use FUSION
were deemed unnecessary since commercially produced
DEMs were available.

 High resolution (3ft) bare earth and top hit DEMs of
San Juan County in 2009 (5.4 GB), processed by
Watershed Sciences, Inc., were provided by the Puget
Sound LiDAR Consortium.  The projection for this data is
the Nad83 HARN Washington State Planes North FIPS
4601. An educational trial version of Esri ArcInfo 10.1
for desktops, Sevice Pack 1, was used throughout this
analysis.
 The bare earth DEM was subtracted from the top
hit DEM to yield a raster representation of vegetation
height. The vegetation height raster was inverted and
then the Flow direction and Basin tools were used to

 Low resolution (30m) representations of land cover
type, forest canopy cover (%), and impervious surface
(%) were obtained from the National Land Cover
Database through the Multi-Resolution Land
Characteristics Consortium. The land cover and
impervious surface data were collected in 2006, but the
most recent forest canopy data available were collected
in 2001. The datasets were clipped to the SJI shoreline in
ArcMap and reprojected to the Nad83 HARN
Washington State Planes North FIPS 4601 projection.
. I-tree Vue 5.0 is another freeware application designed
by the USDA Forest Service.
 In i-Tree Vue, these datasets were analyzed to
estimate ecosystem services including carbon storage
and sequestration, as well as the potential removal of
carbon monoxide, nitrogen dioxide, ozone, sulfur
dioxide, and fine particulate matter (<10µm) from the
air. The option to correct for a small systematic
underestimation of forest canopy and impervious
surface in the National Land Cover Database was
utilized. Simple models were also run to estimate the
change in ecosystem services if the forest canopy were
decreased to 50% coverage or increased to 65%
coverage.



 ModelBuilder was used to link tools and automate
the data processing described above. Each model was
extensively tested for accuracy and smooth execution at
several scales, beginning with small areas and ending
with the whole area of San Juan Island.

delineate trees (>15ft). The Raster to Polygon and
Feature to Point tools were used represent the trees as
vector polygons and their centroid points. Trees located
in Urban/Impervious Surface areas of the reprojected
land cover image derived from SPRING were removed as
false positives. Trees were assigned a height field from
the value of the vegetation raster cell at their centroid.
Rasters (1 acre resolution) representing average tree
height and tree density were created using the Point to
Raster tool.
 Forest canopy coverage was independently
calculated from the treetop points and the vegetation
height raster. The overlap between the treetop polygons
and the raster (1 acre resolution) was calculated by
transforming each cell into a polygon and using the
Intersect and Dissolve tools. Then the polygons were
transformed back into a forest canopy raster using the
Polygon to Raster tool. High-value (>15 ft) cells in the
vegetation height raster were summed using the
Aggregate tool to create a second forest canopy raster (1
acre resolution).
 The forest canopy rasters and the average tree
height raster were input to Lefsky's above ground
biomass equation using the Raster Calculator.



 Spring produced a land cover raster with three
classes: Forested (66.69%), Non-forested
(29.79%), and Urban/ Impervious Surface (3.47%)
(Fig 1). A few pixels were not classified (0.05%)
due to programmatic error.

 Visual inspection of a small area (Fig 2) shows
that the segmentation step distinguished all
features visible to the naked eye and more.
However, the classification of these features is
not perfect. For example, the small pond in the
upper left quadrant is incorrectly classified as
“Forested” because it is dark green. Manually
classifying more pixels to “train” the program
should improve the raster.

 The Urban/Impervious Surface class is the
most important to this preliminary study, because
it is used to distinguish rooftops from treetops
later in the workflow. SPRING’s segmentation
process is easier and more sensitive than the
manual digitization that San Juan County
currently uses to locate impervious surfaces.

  Although it is a touchy program overall and
has trouble processing large image, we
recommend including SPRING in future workflows
(Fig 3).  Perhaps a volunteer fluent in Portuguese
could be recruited to translate technical support
information if necessary. The land cover raster
resulting from this preliminary study could be
recreated with more accurate classification,
especially if volunteers helped “train” SPRING.
Kwiaht could also use SPRING to remote sense
a more complicated land cover raster for the
benefit of their other ongoing projects, such as
mapping habitat types on all public lands in San
Juan County.



Figure 1: SPRING land cover classification: a) orthophotography input, b) land cover raster output.



Figure 2: SPRING land cover segmentation and classification: a) orthophotography input, b) segmentation step,  c) land cover raster output.

a)

b)

c)



Figure 3: SPRING workflow diagram.



  The maps output by i-Tree Vue show the expected
geographic patterns. Impervious surface is most
abundant in the town of Friday Harbor and forest is
more abundant on the north end of the island (Fig 4).
The greatest delivery of ecosystem services such as
carbon storage, carbon sequestration, and air pollution
removal happens in the same forested areas (Fig 5).

 I-Tree reports more impervious surface (4.5%) and
less forest (58.1%) than the land cover raster output by
SPRING, I-Tree analyzed data from 2001 and 2006,
while SPRING analyzed data from 2011, so we would
expect to see more developed land in the SPRING
analysis. The difference probably appears because the
data analyzed by  i-Tree had lower resolution, and were
classified without the benefit of local knowledge. I-Tree
Vue also creates scenarios with varying forest canopy
cover (Fig 6). The scenario of increased forest canopy
cover could be used to account for the disparity.

 The strength of i-Tree lies in the sophistication of the
ecosystem classifications.  A more intensive study could
duplicate these land cover classifications using SPRING.
But comparing the mass of carbon storage and

sequestration delivered by each forest type confirms that
evergreen forests are the most common forest type and
the most important carbon sink on San Juan Island
(Table 1). So perhaps the other forest types do not need
to by included in this study.

 According to i-Tree, the forests of San Juan Island
provide $1.5 million worth of carbon sequestration each
year, and 47.7 million worth of carbon storage. The
evergreen forests alone provide $1.4 million worth of
carbon sequestration each year, and $42.5 million
worth of carbon storage. Even accounting for a wide
margin of error, these large numbers reflect the
monetary value of not cutting down trees.

 We recommend comparing the outputs of i-Tree to
the outputs of other analysis methods. The i-Tree
workflow (Fig 7) parallels the other analyses, but uses
completely different data sources and calculations.
Therefore it provides a useful data point against which
other more customized methods can be checked.



Figure 4: I-Tree Vue land cover classifications: a) forest canopy coverage,  b) impervious surfaces coverage



Figure 5: I-Tree Vue forest ecosystem services output a) carbon storage and sequestration  b) pollution removal.



Figure 6: I-Tree Vue forest canopy change scenarios: a) decreased forest canopy  b) increased forest canopy coverage



Table 1: I-Tree Vue measurement of carbon sequestration and storage by land cover type.



Figure 7: I-Tree Vue workflow diagram



Figure 12: Vegetation height outputs from ArcMap hydrology tools.



 The analysis in ArcMap delineated trees from high
resolution LiDAR derived DEMs. A toolbox was also
created in order to streamline and automate a
repeatable process. The toolbox contains eight
ModelBuilder models (Fig 8).

 The vector representation of individual trees
produced by ArcMap hydrology tools were the most
exciting data gathered by this study (Fig 9).
Approximately 2.7 millions trees were identified. Model
1 simply creates a “vegetation height” raster from the
bare earth and top hit DEMs. Model 2 delineates the
individual trees in the study area by inverting the
vegetation heights, and then using hydrology tools
available in Spatial Analyst. This is limited by a user
defined minimum height which removes non-forested
area from the raster coverage. (Fig 10)

 The land cover raster created in SPRING eliminated
false positives caused by rooftops, as shown in Model 3.
Model 4 finally assigns the approximate height values to
the tree points. (Fig 11)

 The vegetation height outputs (Fig 12,13) show a
similar geographic distribution of trees to that which

appeared in the forest cover outputs of SPRING and i-
Tree. But new patterns become visible when tree heights
are represented. Notice that the tallest forest is in the
University of Washington’s biological reserve, which
has been protected since 1921. The forested areas of the
San Juan Island National Historical Park are also
exceptionally tall. The tallest areas do not correspond to
areas with lower density of trees per acre, which we
expected because the forests are immature and the trees
have plenty of space left to grow.

 The raster data summarizing the individual tree
vectors (Fig 13) are comparable to forest cover rasters
but more sensitive. For example, the pastureland in the
center of the island is crisscrossed by scrubby
hedgerows, which are only visible in the ArcMap
output. Model 5 generates the trees per acre and the
average tree heights per acre rasters (Fig 14).

  Model 6 uses tree polygons (vector analysis) to
calculate forest canopy cover percent per acre (Fig 14),
and Model 7 does the same but using the minimum
vegetation heights with false positives removed (raster
analysis) (Fig 15). Finally, Model 8 generates the
estimated above ground biomass per acre raster based
on Lefsky’s regression analysis equation using the



Figure 8: ArcMap toolbox

average height raster and forest cover percent raster
(Fig 15).

 The two methods for calculating forest canopy cover,
from tree polygons or vegetation pixels, create virtually
indistinguishable maps (Fig 16). The maps of above
ground biomass derived from them are similarly
indistinguishable (Fig 17). The vector method creates a
slightly higher estimation of above ground biomass
(3,875,731.66 mg/ha) than the raster method
(3,800,371.21 mg/ha) but with 84% certainty at best,

the values are not significantly different. Since these two
values are so close, we recommend using the raster
method in Model 7 in the interest of saving time. Model
7 runs in about a minute while Model 6 requires over
twenty minutes. Running both Models, though, allows
results to be cross-checked.



Figure 9: a) LiDAR derived vegetation height raster b) LiDAR derived vegetation height raster with delineated tree polygons and points.



Figure 10: ModelBuilder diagram of Model 1 and Model 2



Figure 11: ModelBuilder diagram of Model 3 and Model 4.



Figure 13: Tree counts and average tree height rasters output from ArcMap.



Figure 14: ModelBuilde diagrams of Model 5 and Model 6.



Figure 15: ModelBuilder diagrams of Model 7 and Model 8.



Figure 16: Forest canopy coverage rasters



Figure 17: Above ground biomass rasters output from ArcMap.



 The workflow presented here weaves together
several methodologies and remote sensed data sources.
Fusion and SPRING create rasters which can be analyzed
with the ArcMap toolbox. I-Tree provides an alternative
analytical track. (Fig 18) They should be used to survey
all the forests of San Juan County in greater detail.

 Although these remote sensing methods are
powerful, ground-truthing will be an important
component in the next stage of the study. Botanical
ecologist need to survey the forests from the ground up.
Because we focused on freeware and free data, the only
cost would be labor.  Kwiaht’s executive director
estimates that continuing this study with improved
accuracy would cost approximately $33,553 (Table 2).

 New orthophotos of San Juan County were collected
during the summer of 2013. As soon as these images are
available, Kwiaht should use SPRING to create a very
detailed land cover raster, detailing different forest
types. Any volunteer could easily learn to identify pixels,
and many of Kwiaht’s regular volunteers are
comfortable studying aerial imagery. They also have a
collective pool of local knowledge about forests they

regularly explore. Entering more “training” points will
make the result more accurate. They could also produce
a much more complex result than the “test run”
produced by this study.

 As mentioned earlier, the land cover raster will serve
many purposes. The “Urban” class may be the best
picture of impervious surfaces available in San Juan
County, and it can be used to distinguish building peaks
from treetops in the LiDAR analysis. A high resolution
remote-sensed land cover raster could provide a lot of
information about the habitat types provided by public
lands and reserves. It would be particularly invaluable
on small outlying islands which are difficult to reach,
and where fieldwork could cause significant ecological
disturbance.

 The ArcMap toolbox for delineating trees from DEMs
is ready for action. But the only available LiDAR data is
from 2009. A botanist needs to measure tree height and
tree location on sample plots (Fig 19), to see how much
the forest has changed over the last four years. How
many trees have been cut down? How much taller have
the trees grown? Only ground-truthing can answer
these questions and quantify the error and uncertainty
in the LiDAR analysis.



 Biomass is the easiest metric of carbon to use.
Allometric equations in the literature most commonly
calculate above ground biomass, not carbon storage or
carbon sequestration. The biomass of plant tissue
samples could also be measured with laboratory
equipment Kwiaht already owns. In fact, they regularly
measure the biomass of plankton samples; perhaps
someday this project will expand to study the other
major carbon sink in San Juan County.

 I-Tree will put a price tag on the biomass of the
forests. Modeling the effects of offering tax breaks for
forests might be a more pragmatic way to measure the
monetary value of ecosystem services. However, an
outreach and education program should be included in
the study, because it is crucial that stakeholders,
particularly land owners and public officials,
understand what they are buying.

Table 2: Itemized budget projection for labor costs in the next phase of the study.



Figure 18: Overall workflow diagram integrating Fusion, Spring, ArcMap,a nd i-Tree.



Fig 19: Swimlane diagram detailing the roles of GIS analyst, botanist, and other Kwiaht staff in extended study.
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 The National Agriculture Imagery Program data
collected for this analysis was from the USDA Geospatial Data
Gateway website (http://datagateway.nrcs.usda.gov).This data
is an aerial photography mosaic of the majority of the United
States with a1 meter cell size resolution. ArcCatalog can also
directly connect to their GIS servers through this URL:
http://gis.apfo.usda.gov/arcgis/services.  The projection
chosen by this agency is Nad83 UTM Zone 10N, Albers
Conformal Conic. This is important to note, as applying the
products to other datasets in ArcMap could require care in
reprojecting data.
 Although NAIP 4-band data is collected, this report
used 3-band data. The online system for attaining 4-band
data was out of order, as well as there being an extra financial
cost in attaining 4-band datat. The fourth band  is a near-
infrared spectrum that is extremely good for detailing plant
growth in the imagery.
 As a general note on SPRING, only the 32 bit version
works, and it is a touchy program overall, and has trouble
processing large images. The NAIP imagery for San Juan
County is several gigabytes. Extracting a smaller area of an

the image to limit the file size can be done in ArcMap. Next,
the image is exported from the ArcGIS environment as a
georeferenced *.tif file.
 After downloading and installing SPRING, a new
database is created(File > Database…) to house all the data
and outputs, a new Project is started in the software to begin
work with our 3-band image (File > Project…), and the image
is loaded into the software (File > Import > Import Vectorial
and Matricial Data).
 SPRING requires the projection of the image to be set
manually in the New Project window. NAIP data is in the
Nad83 UTM Zone 10N projection, and must be entered
accordingly. Also, SPRING needs to know the spatial extent of
the project to examine, and this is set in the “Bounding Box”
section in the window. The extent can be copied from the
extents given in ArcMap for extracted image. After setting
these parameters, the image can be loaded.





After entering the projection, extent, and the image itself, conduct
a segmentation (Image > Segmentation). Segmentation
automatically divides the image into “objects”, or features. In the
Segmentation window, all three bands were selected at the top.
This window is also where you enter the “Similarity” and “Area”
values. Similarity will “tell” SPRING how similar the pixels need to
be in order to be grouped together. A lower similarity value will
result in a more detailed segmentation. Area “tells” SPRING the
minimum number of pixels allowable to be segmented as a single
feature. This segmentation process requires many runs at different
values for the two parameter so you can get a feel for the resulting
level of detail in the segmentation.

As noted earlier, SPRING is touchy about data size of the imagery.
Because of this, the segmentation and classification steps in this
analysis had to be completed by halving the island. The original
imagery was left loaded as normal, but in the segmentation
window, the Bounding Box was adjusted. Simply find the midpoint
of the Y1 and Y2 points, enter it in Y1 or Y2 such that the island is
split (for processing by SPRING) into north and south halves.
Unfortunately, this means added time in processing the island
overall because you have to do it twice (north and south), however,
it is an effect work around. The alternative is to have SPRING
simply close itself without warning or explanation.



The island image was then classified, via segmented features.
Under advisement from the project sponsors, this analysis only
includes three land use types: Forest, Grassy or Non-Forest, and
Urban. Urban is a catch-all for impervious surfaces like roads and
buildings. Delineating the buildings is especially helpful in the
ArcMap Model Builder exercise of forest delineation to remove
false positives for trees that were actually structures.

In order to classify regions, the user has to “train” SPRING as to
what pixels are what land use types. This is done in the Training

window accessed from the Classification window. (Image >
Classification > Training). Here, the classes are named, assigned a
color, created, and then target pixel groups are selected and
assigned to the possible classes. In this analysis, several million
pixels were assigned to the classifications in order to make sure the
entire image was reclassified.

The image reclassification was finished in the “Classification”
window (Image > Classification > Classification).



The north and south classifications were brought together as one
with the Image > Mosaic menu function. Then the resulting
reclassification for the whole island was exported as a *.tif
georeferenced image for use in ArcMap.

Please see Monskal et al.’s 2011
 if any further detail about SPRING segmentation and

classification is desired. Again, the segmentation and classification
processes here are a product of working through the workshop
document, and summarized for this report.

 Two applications in the i-Tree suite were considered in this
analysis, i-Tree Vue and i-Tree Canopy. Vue is the more in depth
analysis application as it actually uses national averages of
different forest metrics in order to give outputs that describe
ecosystem services. This application uses data from the National
Land Cover Database (NLCD), which is generated by the federal
government and describes all the contiguous states in terms of 26
possible land cover types. The NLCD also has maps for the amounts
of forest canopy cover (%) and impervious surfaces (%). The maps
are at a 30 meter resolution, and are obviously not as detailed as
the PSLC or NAIP datasets previously discussed.
 i-Tree Vue requires all three of these inputs, land cover,
canopy, and impervious, for the entire area of study. These data for
the area of interest, San Juan Island, were downloaded from the
Multi-Resolution Land Characteristics Consortium (MRLC)
website: www.mrlc.gov/viewerjs/. This is a map view from which
you can zoom to, and download data for an area. In this analysis,

SJI was zoomed into, and then the Data Download Tool was used
to get the data after selecting the options: Land Cover 2006,
Impervious Surface 2006, and Forest Canopy 2001.
 These three datasets can be extracted in ArcMap to the
same boundaries used for the previous SPRING and ArcMap
analyses. This process ensured the exact same spatial extent for all
images entered into Vue.
 Enter these images in the three locations asked for at the
beginning “NLCD Imagery” i-Tree Vue page.After loading the
imagery into the application, under “Analysis Options,” Vue has the
option to make adjustments to the Canopy and Impervious Surface
images based on research from 2010 that showed that the NLCD
process in general underestimates these two percentage output
images. Finally, the application runs for the analysis of carbon
storage and sequestration, and air pollution removal. Each analysis
presents an image of the study area’s potential to handle carbon or
pollution metrics, as well as a report of the pounds and possible
dollar values as an ecosystems service the forest is providing.
 The application also allows you to run a simple model
where you can  estimate the change of ecosystem services based on
a decrease or increase of the forest canopy coverage for the study
area. As the initial estimation by Vue was that the island has a
forest canopy of 58.1% already, a model was run for a decrease to
50% canopy, as well as one run for an increase to 65% canopy.

The i-Tree Canopy application uses imagery directly
accessed from Google Maps. In short, the user defines an area of
interest, and then enters into the application the possible
classifications for land use or land cover. The area of interest is best
defined using an Esri shapefile to delineate boundaries. Then, the



software randomly generates a point x and y coordinate, zoomes
the display window into it on Google Maps satellite images, and the
user picks what classification that point belongs to. This is done
over and over again, until the user thinks there have been enough
samples to get a good feel for the land use cover. The software
advocates for 500 to 1,000 points to be sampled. The output is
nothing more than a table showing the percentage of land use
classes for the study area.This application is better suited for more
urbanized areas than San Juan Island, and would be good at
determining several urban land use possibilities within city limits.
 There are several other i-Tree application available in the
i-Tree 5.0 software suite. Eco, Streets, Species, Hydro, and Storm all
perform different functions for estimating ecosystem services like
carbon storage, stormwater runoff mitigation, and modeling
change over time. However, they are considered out-of-scope for
this reports since they all require data inputs other than remote
sensing options. For instance, i-Tree Eco is a very  powerful
application to estimate many urban forest services, but it requires
boots-on-the-ground survey and data collections on forested
areas.

 Fusion  is a freeware application that was downloaded
from the USDA Forest Service’s Pacific Northwest Research
Station website
(http://forsys.cfr.washington.edu/fusion/fusionlatest.html). This
site provides the installation for the software and also an example
data set to use in extensive tutorials that are available from the
Forest Service at this link:

http://www.fs.fed.us/eng/rsac/fusion/ie5/index.html?dhtmlActivati
on=window.
 Although there was success at running through sample
data in the Fusion application, there was not success in trying to
incorporate our raw data in *.las formatted files. There is little
doubt after examining sample data and tutorial exercises that
Fusion is a power application where the user can execute great
control on the outputs and metrics attempted. However, for this
analysis, we are compelled to leave the use of Fusion up to the very
software savvy individual who can dedicate the appropriate large
amounts of time to learning the software, practicing it, and
working out and around the problems that may arise.

 Esri’s ArcGIS suite is capable of delineating many outputs if
public domain lidar data is available. The Puget Sound Lidar
Consortium (PSLC) is an online source for such data for the Puget
Sound area, but the coverage and resolution is not consistent for
the entire region. Luckily, PSLC has posted the three foot resolution
bare earth and top hit DEMs for all of San Juan County. PSLC also
has links to raw point cloud data that these DEMs are derived from.
 Download the PSLC DEMs and add them to a new
geodatabase in ArcCatalog (i.e. SanJuanIslandLIDAR.gdb) on a
drive with a lot of data storage available. This is the workspace for
the whole analysis. Set the scratch workspace in Environment to be
the same *.gdb. This is a data storage space-heavy sequence of
analysis. Maintain the original projection of the DEMs as the
default for the entire process.



 Within ArcMap, beginning with bare earth and top hit
DEMs, one can derive the height of vegetation (and all structures),
delineate individual trees as both polygons and XY points, and
create rasters of trees per acre, average tree height per acre, and
forest canopy percent coverage per acre. Above ground biomass
(ABM) can be calculated also using the outputs for canopy cover
and mean height. There are many steps to achieve these outputs.
Model Builder is a utility inside the ArcGIS suite for linking tools
and scripts to automate data processing. This is especially useful in
this situation given the many steps required, and the desirability of
a workflow process that can be repeated on past and future DEMs
that become available.
 Each Model step is graphically presented with detail in the
Results section. Each Model in the Toolbox accepts plainly labeled
“INPUT”s and derives “OUTPUT”s. Also, each Model gives a
suggestion for the name of the “OUTPUT” feature class, and
subsequently suggestions for names of “INPUT”s based on previous
Model outputs. Some intermediate data are set as parameters in the
Models and are simply numbered. The intermediates are saved for
examination by the user if necessary for troubleshooting or simply
if desired.
 There is no reason why a user has to be stuck using an acre
as the resolution for trees per area or forest percent per area. These
models are set up to use 1 acre as the default values only. To
change outputs to a different value, run the models as before, but
change the parameters in this list:

Models 1 – 4. All remain the same. You do not have to re-run these.
Model 5.

Cell size of output raster (1 acre is 208.7103 ft cell size)

Model 6a. No change, but you must re-run.
Model 6b.

Enter the same cell size as your template  raster in 6a. (e.g.
TreesPerAcre is 208.7103 for 1 acre cells)

Model 7.
Multiplier to new cell size: For an acre, enter 64 if 1m res.
raster used, or 70 if 3 ft. res. raster used

(Your chosen cell size / Resolution of your input
Vegetation Height raster in feet) round off to integer
value

E.g. Model default uses the VegHeigh_min15_nonBuilding
raster. This is a 1 m resolution because it was generated
using the NAIP land use raster created in SPRING at Model
3. Resolution in feet: 1m  =  3.28 ft

(acre / your res) , round off to integer
(208.7103 ft / 3.28 ft) = 63.63
Rounded off to 64

E.g. 2

(1000/ your res) , round off to integer



(1000 ft / 3.28 ft) = 304.87
Rounded off to 305
Area of an acre OUTPUT: 43560 square feet

Model 8. No change, but you must re-run.
All the output rasters are now at your new cell size.
E.g. Trees per 1 mill. square feet.
Forest percents, and zonal statistics are automatically correct
because they are based on internal Shape_area metrics in the first
place and cell size does not matter.


